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1. Introduction
This manual describes the TitanSDR user interface and its mode of use.
Before using the product, make sure to have correctly performed all the steps in the
Installation Manual.
TitanSDR is an HF multi-channel receiver allowing up to four independent wideband
channels within the 0-40MHz band and several narrowband channels (up to 8 and
40 in the TitanSDR and TitanSDR-Pro versions of the product, respectively), which can
be tuned within wideband channels.
Each narrowband channel supports, at the same time, demodulation, recording
(onto WAV files) and streaming of demodulated signals to: VACs (Virtual Audio
Cables), sound cards, Hoka Electronic CODE300 decoders (via LAN).
Figure 1 exemplifies diagrammatically the operation described above.

Figure 1 - Functional diagram
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1.1

User interface architecture

Figure 2 shows schematically the user interface architecture.

Figure 2 - User interface architecture
The user interface is composed of:





Main Toolbar
Panoramic Scope
Wideband Scope
Narrowband Scope

On the Main Toolbar (Figure 3) there are a series of drop-down menus (File, Mode,
NB List, Memory, Schedule, View, Options) that allow to access the features
described in detail in Chapters 2, 3, 4 of this manual.

Figure 3 - Main Toolbar
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Panoramic Scope, Wideband Scope and Narrowband Scope are windows in which
visualization and control of panoramic spectrum, wideband channels and
narrowband channels, can be performed, respectively.
As illustrated in Figure 2, Wideband Scope and Narrowband Scope are positioned
under the Panoramic Scope, which in turn is just under the Main Toolbar.
In order to make resize of windows possible, these are separated by splitters, namely
graphics draggable separators, which allow to increase (or decrease) the size of
the window of interest, to the detriment (or advantage) of the others.
Clicking on a splitter, its position can be moved by mouse dragging (with the left
mouse button hold down).

Figure 4 - Splitters drag directions
Figure 4 shows directions in which splitters can be dragged inside the user interface.
Note the presence of splitters also within windows of Wideband and Narrowband
Scope (see Chapter 1.2 for a detailed description). Figure 5 shows a screenshot of
the user interface during typical operation.
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Figure 5 - TitanSDR user interface

1.2

Panoramic Scope, Wideband Scope and Narrowband Scope

In this paragraph, the high-level structure of Panoramic Scope, Wideband Scope
and Narrowband Scope is described.
Panoramic Scope:
It is composed of its own toolbar, a panoramic spectrum window and a reference
bar representing the frequency axis. The toolbar contains commands that allow to:
• control front-end settings
• manage spectrum settings
• allocate and deallocate wideband channels
The panoramic spectrum window shows spectrum of the 0 - 32MHz band managed
by the receiver (see par. 4.5.1 to show up to 40MHz). The reference bar is draggable
horizontally, after at least one frequency zoom-in step (see Chapter 2.1.2).
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Wideband Scope:
The Wideband Scope shows the spectrum of the wideband channel which is
currently selected on the Panoramic Scope, at a higher resolution and its “waterfall"
representation. The frequency bar (placed below the spectrum plot) is draggable
horizontally after at least one frequency zoom-in step (see Chapter 2.2.1).
Spectrum plot and waterfall display are separated by a splitter, which allows to vary
the vertical dimension of the two windows (Figure 4).
Narrowband Scope:
The Narrowband Scope shows the spectrum of the narrowband channel which is
currently selected within the Wideband Scope, with a higher resolution and its
“waterfall” representation.
Spectrum plot and waterfall display are separated by a splitter, which allows to vary
the vertical dimension of the two windows (Figure 4).
Panoramic Scope, Wideband Scope and Narrowband Scope can be possibly
shown or hidden by selecting or deselecting the corresponding items of the "View"
drop-down menu on the main toolbar (Figure 6).

Figure 6 - View menu

1.3

Software startup

The user interface, shown in Figure 8, appears by double-clicking on the TitanSDR
software icon (see Figure 7).

Figure 7 - TitanSDR software icon
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Figure 8 - User interface of TitanSDR
TitanSDR can be operated in the following two modes:


Receiver Mode



Player Mode

with the ability to switch between them without restarting the software.
Receiver Mode: software allows to control the receiver and to manage all
operations on radio channels (all of the functions of this mode are described in
Chapter 2).
Player Mode: software allows to playback files (written in a proprietary format) which
resulted from previous recording of wideband channels in Receiver Mode (see
Section 2.2.3) and to perform the same operations allowed on wideband channels
in Receiver Mode (allocation and recording of narrowband channels,
demodulation, listening of demodulated audio, data streaming by VAC, LAN, ...).
All Player Mode functions are described in Chapter 3.
Mode choice is made through the menu "Mode" (Figure 9) on the Main Toolbar. The
default setting is Receiver Mode.

Figure 9 - Mode setting
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2. Receiver Mode
After selecting the Receiver Mode (from menu "Mode" on the Main Toolbar), as
shown in Figure 9, press the connect USB button illustrated in Figure 10.

Figure 10 - USB button before connection
This button is used to start communication between the software and the receiver.
If connection is successful, the button symbol changes color (from red to green, see
Figure 11) and the input 0-32MHz spectrum appears on the Panoramic Scope (Figure
12).

Figure 11 - USB button after connection

Figure 12 - User interface after successful connection with receiver

2.1

Panoramic Scope

2.1.1

Front End settings

Receiver Front-end settings can be changed by the Front End controls group of the
Panoramic Scope toolbar (Figure 13).
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Figure 13 - FrontEnd controls group
Settings may regard:
• Selection of a preselection filter
• Change of input attenuation value
• Receiver input selection
Selection of preselection filters:
The list of possible sixteen preselectors appears by clicking on the first drop-down
menu of the FrontEnd controls group (Figure 14). Each preselector/filter is
characterized by its own passband, whose frequency extremes are indicated in the
list. The All Pass choice is also possible (default), causing the receiver to perform no
preselection on RF input signal.

Figure 14 - Preselection filters list
Setting of the RF attenuation value:
RF attenuation can be set from 0dB to 30dB, in steps of 10 dB. Clicking on the second
drop-down menu of the FrontEnd controls group, a list appears of attenuation values
that can be selected (Figure 15). Default value is 0dB.
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Figure 15 - List of selectable attenuation values
Receiver input selection:
By clicking on the third drop-down menu of the FrontEnd controls group, selection
can be made of the receiver input (Figure 16). The “IF” choice corresponds to the
SMA connector marked "IF IN" on the receiver rear panel, whilst the “HF” choice
corresponds to the BNC connector marked "ANT. IN ". Default receiver input is “HF”.

Figure 16 - Receiver input selection

2.1.2

Spectrum settings

The graphical settings of the Panoramic Scope spectrum can be changed by the
Spectrum controls group of the Panoramic Scope toolbar (Figure 17).

Figure 17 - Spectrum controls group
The actions that can be performed are:
• selection of windowing (for FFT)
• selection of spectrum averaging time period
• spectrum (frequency) zoom/dezoom
• automatic custom setting of max/min spectrum amplitudes
Furthermore, in order to shift the displayed frequency interval, dragging of the
frequency axis bar is also possible.
Selection of windowing (for FFT)
By clicking on the first drop-down menu of the Spectrum controls group, selection
can be made of FFT windowing. (Figure 18). Default is “Blackman”.
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Figure 18 - Windowing alternatives
Selection of spectrum averaging time period
By clicking on the second drop-down menu of the Spectrum controls group, a list
appears of possible averaging time periods that can be selected (Figure 19). Default
setting is "NO AVG", meaning that spectra are plotted on the Panoramic Scope
without any averaging.

Figure 19 - Spectrum averaging time periods
Spectrum (frequency) zoom\dezoom
Click zoom/dezoom buttons to enable the zoom function (mouse cursor changes
into magnifying glass). Zoom/dezoom can then be accomplished by left clicking or
turning mouse wheel up/down. Zoom/dezoom aims to the frequency value
corresponding to mouse cursor position on spectrum plot (Figure 20). Further click
on zoom/dezoom buttons to disable the zoom function, restoring the standard
mouse cursor.

Figure 20 - Panoramic Scope spectrum
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Buttons for zoom/dezoom are shown in Figure 21 and are positioned within the
Spectrum controls group of the Panoramic Scope toolbar.

Figure 21 - Spectrum zoom/dezoom buttons
Figure 22 shows the Panoramic Scope after zooming the spectrum of Figure 20, by
clicking on the zoom button (the one marked with a “+”).

Figure 22 - Panoramic Scope after horizontal zoom
Automatic custom setting of max/min spectrum amplitudes
Panoramic spectrum can be resized upward/downward by clicking up/down
arrows (Figure 23).

Figure 23 – Upward/downward spectrum resize buttons
Dragging of the frequency axis bar
After having zoomed once (at least), the displayed frequency interval can be
shifted downwards or upwards by simply left clicking on the frequency axis bar of
the Panoramic Scope (Figure 24) and dragging it leftward or rightward, respectively.

Figure 24 - Frequency axis bar of the Panoramic Scope
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2.1.3

Management of wideband channels

The WB Channels controls group of the Panoramic Scope toolbar (Figure 25) allows
to perform the following operations:


allocation of a wideband channel



selection of a previously allocated wideband channel



tuning of a wideband channel



deallocation (removal) of a wideband channel

Figure 25 - WB Channels controls group
Allocation of a wideband channel:
By clicking on the "ADD" button of the WB Channels controls group, a list appears of
available bandwidth sizes (Figure 26) for the new wideband channel to allocate
(see Appendix).

Figure 26 - List of available bandwidth sizes
A new wideband channel is allocated by clicking on one of the available
bandwidth sizes. Its position and frequency extent is represented by a colored
shaded area on the Panoramic Scope spectrum (Figure 27), whilst its center
frequency is indicated in the edit box of the WB Channels controls group (Figure 25).
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Figure 27 - Wideband channel shaded area
By default the new wideband channel is allocated within the Panoramic Scope at
the far left of the displayed spectrum. The allocated channel is assigned one of the
following names: WB1, WB2, WB3, WB4.
To facilitate identification of wideband channels and to distinguish them from one
another, their shaded areas are assigned a color, based on the following color
convention:
- WB1: RED shaded area
- WB2: GREEN shaded area
- WB3: BLUE shaded area
- WB4: PURPLE shaded area
Selection of a wideband channel
When more than one wideband channel has been allocated (Figure 28), a specific
wideband channel can be selected by clicking on its name in the first drop-down
menu of the WB Channels controls group (Figure 29).

Figure 28 - Sample scenario with four wideband channels
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Figure 29 - WB Channels drop-down menu
For each allocated wideband channel, both center frequency and bandwidth are
provided in the same drop-down menu. By selecting a wideband channel, its
shaded area becomes brightly colored.
Tuning of wideband channels
Tuning of selected wideband channel within Panoramic Scope spectrum can be
obtained:


modifying by keyboard the center frequency Edit box of Figure 30. Any
change in the Edit box is given effect to by pressing Enter;



turning of mouse wheel up/down after selection of any one digit in the Edit
box of Figure 30. The center frequency increases/decreases by (the
frequency step of) a unitary increase/decrease of that digit;



dragging its shaded area. While dragging, the wideband channel center
frequency is modified accordingly in the frequency edit box of the WB
Channels controls group (Figure 30).

Figure 30 - Center frequency edit box
The padlock icon color in WB Channels controls group (Figure 30) points out if a
wideband channel is tunable (green) or not (red). Wideband channel is tunable if
contains at most one narrowband channel.
The unit of measurement of the wideband channel center frequency can be
selected by the second drop-down menu of the WB Channels controls group (Figure
31). Possible choices are: Hz, KHz or MHz .

Figure 31 - Unit of measurement of WB channel center frequency
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Deallocation of wideband channels
The selected wideband channel can be deallocated by clicking on the trash button
(Figure 32) of the WB Channels controls group (Figure 30).

Figure 32 - Trash button
As a result of this action, its shaded area disappears from the Panoramic Scope
spectrum and its name is removed from the wideband channels drop-down menu
(of Figure 29).
In order to perform deallocation of a wideband channel, it must be “empty”, i.e. no
narrowband channel must be present (allocated) inside it (see par. 2.2.2).

2.2

Wideband Scope

2.2.1

Spectrum settings

The graphical settings of the Wideband Scope spectrum can be changed by the
Spectrum controls group of the Wideband Scope toolbar (Figure 33).

Figure 33 - Spectrum controls group
The following operations are possible:
• selection of spectrum averaging time period
• frequency zoom/dezoom
• automatic custom setting of max/min spectrum amplitudes
Furthermore, in order to shift the displayed frequency interval, dragging of the
frequency axis bar is also possible.
Selection of spectrum averaging time period
By clicking on the drop-down menu of the Spectrum controls group, a list appears
of possible averaging time periods that can be selected (Figure 34). Default setting
is "NO AVG", meaning that spectra are plotted on the Wideband Scope without any
averaging.
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Figure 34 - Spectrum averaging time periods
Frequency zoom/dezoom
Click zoom/dezoom buttons to enable the zoom function (mouse cursor changes
into magnifying glass). Zoom/dezoom can then be accomplished by left clicking or
turning mouse wheel up/down. Zoom/dezoom aims to the frequency value
corresponding to mouse cursor position on spectrum plot (Figure 35). Further click
on zoom/dezoom buttons to disable the zoom function, restoring the standard
mouse cursor.

Figure 35 - Wideband Scope spectrum and waterfall
Buttons for frequency zoom/dezoom are shown in Figure 36 and are positioned
within the Spectrum controls group of the Wideband Scope toolbar.

Figure 36 - Zoom/dezoom buttons
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Figure 37 shows the Wideband Scope after zooming the spectrum of Figure 35, by
clicking on the zoom button (the one marked with a “+”)

Figure 37 - Wideband Scope after zooming
Automatic custom setting of max/min spectrum amplitudes
Wideband channel spectrum can be resized upward/downward by clicking
up/down arrows (Figure 38).

Figure 38 – Upward/downward spectrum resize buttons
Dragging of the frequency axis bar
After having zoomed once (at least), the displayed frequency interval can be
shifted downwards or upwards by simply left clicking on the frequency axis bar of
the Wideband Scope (Figure 39) and dragging it leftward or rightward, respectively.

Figure 39 - Frequency axis bar

2.2.2

Management of narrowband channels

The NB Channels controls group of the Wideband Scope toolbar (Figure 40) allows
to perform the following operations:


allocation of a narrowband channel



selection of a previously allocated narrowband channel



deallocation (removal) of a narrowband channel.
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Tuning of a narrowband channel is achieved by mouse dragging its shaded area or
double clicking on waterfall or spectrum.

Figure 40 - NB Channels controls group
Allocation of a narrowband channel:
By clicking on the "ADD" button of the NB Channels controls group, a vertical yellow
line appears on the Wideband Scope spectrum and waterfall (Figure 41),
representing the carrier frequency of the narrowband channel to be allocated.
Near to the yellow line, a hint label appears also, indicating the corresponding
frequency value.

Figure 41 - Carrier frequency (yellow line) of narrowband channel to allocate
The carrier frequency can be set by mouse dragging the yellow line to the wanted
position and clicking the mouse left button both on spectrum or waterfall. Pressing
Shift key on keyboard while left clicking mouse rounds the carrier frequency to the
nearest whole hundreds or thousands Hz (selectable by Options->Narrowband>Tuning Round). After clicking, the narrowband shaded area appears on the
Wideband Scope spectrum (Figure 42), to the right of the yellow line, being USB the
default mode. A narrowband channel allocation can also be directly achieved by
mouse right clicking on Wideband Scope spectrum or waterfall in correspondence
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of the desired frequency and keeping pressed Shift key on keyboard rounds the
frequency to the nearest whole hundreds or thousands Hz.

Figure 42 - Allocated narrowband channel
As a consequence of the same mouse click, the Narrowband Scope (Figure 43)
becomes ready to operate on the newly allocated narrowband channel, displaying
its spectrum and waterfall with higher resolution than the Wideband Scope.

Figure 43 - Wideband Scope and Narrowband Scope. Rounded to whole hundres
Hz, compare with Figure 41
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Mode changing (as written above, every new narrowband channel is allocated as
USB, by default), can be done clicking one of the buttons within the Mode controls
group (as specified in par. 2.3.3).
Every narrowband channel is assigned a unique name, consisting of a prefix for the
name of its wideband channel (for instance, WB1), a separator “-” and a suffix given
by the string “NB” followed by the channel number, which is the first available
integer starting from 1. For example the fourth narrowband channel of the second
wideband channel will be assigned the name WB2-NB4.
Narrowband channels inherit the same color of their wideband channels, which in
turn is assigned according to the color convention indicated in par. 2.1.3.
Selection of a narrowband channel
In order to operate on a specific narrowband channel by the Narrowband Scope,
that channel must be previously selected. By selecting a narrowband channel, its
shaded area becomes brightly colored.
Selection of a narrowband channel can be done in three ways:


Selecting it in the narrowband channels drop-down menu of the Wideband
Scope toolbar (within the NB Channels controls group)



Left clicking on its shaded area (in the Wideband Scope spectrum)



Opening the NB Channels List (see par. 4.2) and clicking on the corresponding
line

Selection in the narrowband channels drop-down menu
A narrowband channel can be selected within the list of allocated channels, which
appears (Figure 44) by clicking on the narrowband channels drop-down menu of
the Wideband Scope toolbar (within the NB Channels controls group).

Figure 44 - Narrowband channel selection by drop-down menu
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Selection by left clicking on shaded area:
A narrowband channel can be selected by left clicking on its shaded area (Figure
45).

Figure 45 - Narrowband channel selection by mouse click
Selection by NB Channels List
First of all, the NB Channels List must be opened by clicking on menu "NBList" (Figure
46) of the Main Toolbar. Each row of the NB Channels List, which is structured as a
table, contains data concerning a specific narrowband channel.

Figure 46 - Menu NB List
Selection of a narrowband channel can be accomplished by clicking on the
corresponding row of the NB Channels List.
Detailed information on how to employ the NB Channels List may be found in par.
4.2.
Tuning of narrowband channels
Tuning of a narrowband channel can be modified by left clicking on its shaded area
(within the Wideband Scope spectrum) and dragging it to the wanted position
(frequency) or selecting the narrowband channel to retune that double clicking on
waterfall or spectrum (keeping pressed Shift key on keyboard to round the
frequency to the nearest whole hundreds or thousands Hz).
Deallocation (removal) of narrowband channels
The selected narrowband channel can be deallocated (removed) by clicking on
the trash button of the NB Channels controls group (Figure 47).
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Figure 47 - NB Channels controls group
In order to deallocate all narrowband channels of the selected wideband channel
(regardless of them being selected or not), click on the trash button labeled “ALL”.
2.2.3

Recording of wideband channels

TitanSDR allows to record a wideband channel in a binary file (proprietary format)
with extension .bin, which is accompanied with a file having the same name, but
extension
.info.
Both
files
are
saved
in
default
folder
C:\Users\xyz\Documents\TitanSDR Archives\WBChannels (‘xyz’ being the logged
user name) or in user selected destination folder (see par. 4.5.4 for details). If the
recording has to be moved to a different directory, both files must be moved.
Recording is split among several files whose size can be user set within the range of
50MB to 2GB (see par. 4.5.4 for details). Files names are assigned automatically (see
par. 4.5.4 for details).
TitanSDR provides the user the possibility of setting the upper limit to the filling of the
hard disk. Ongoing recordings are stopped automatically when the available space
set by the user is exceeded (see par. 4.5.5 for details).
Recording can be:


manual



scheduled: see par. 4.4

Manual recording
In order to visualize the File controls group, expand the Wideband Scope toolbar by
clicking on the expansion button shown in Figure 48.

Figure 48 - Expansion button
Then, to start recording, click the start recording button (Figure 49) within the File
controls group (Figure 50).

Figure 49 - Start recording button
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Figure 50 - Expanded Wideband Scope toolbar

If the user selected destination folder to record the wideband channels is not
detected at record button click a popup appears (Figure 51) warning that
recording
is
ongoing
in
default
folder
“…\Documents\TitanSDR
Archives\WBChannels”

Figure 51 - Wideband channel recording: warning popup for destination folder not
found

Clicking the start recording button implies enabling the stop recording button
(Figure 52). If it doesn’t happen a window pops up (Figure 53) warning that the
recording did not start for the hard disk free space lower than the minimum set to
prevent the drive from being completely filled up by recording (see par. 4.5.5 for
details).

Figure 52 - Stop recording button
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Figure 53 – Wideband channel recording: warning popup not enough disk space

2.3

Narrowband Scope

By selecting a narrowband channel (see par. 2.2.2 Selection of a narrowband
channel), its spectrum and waterfall, as well as its controls, appear in the
Narrowband Scope (Figure 54). Channel name is indicated at top left of window.

Figure 54 - Narrowband Scope visualizing narrowband channel WB1-NB1
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Every narrowband channel is assigned a unique name, consisting of a prefix for the
name of its wideband channel (for instance, WB2), a separator “-” and a suffix
identifying the channel within the wideband channel (e.g. NB1). For example the
first narrowband channel of the second wideband channel is assigned the name
WB2-NB1.
Default spectrum span of the Narrowband Scope is greater than the actual
bandwidth of the narrowband channel, represented by its shaded area. This larger
view helps in fine tuning and adjusting of the channel bandwidth (by filtering).

2.3.1

Spectrum settings

The graphical settings of the Narrowband Scope spectrum and waterfall can be
changed by the Spectrum controls group of the Narrowband Scope toolbar (Figure
55).

Figure 55 - Spectrum controls group
The actions that can be performed are:
• selection of RF or Audio spectrum
• selection of spectrum averaging time period
• frequency zoom/dezoom
• automatic custom setting of max/min spectrum amplitudes
Selection of RF or Audio spectrum
The first drop-down menu of the Spectrum controls group allows to visualize the RF
spectrum (before demodulation) or the spectrum of the demodulated audio signal
(which results from the chosen mode/demodulator), by selecting “RF” or “Audio”,
respectively (Figure 56).

Figure 56 - RF/Audio selection
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Figure 57 and Figure 58 show the Narrowband Scope for RF and Audio visualizations,
respectively, after tuning of the narrowband channel to an AM transmission.

Figure 57 - Narrowband Scope - RF visualization for an AM signal

Figure 58 - Narrowband Scope - Audio visualization for an AM signal

TitanSDR – User Manual

30

Selection of spectrum averaging time period
By clicking on the second drop-down menu of the Spectrum controls group, a list
appears of possible averaging time periods that can be selected (Figure 59). Default
setting is "NO AVG", meaning that spectra are plotted on the Narrowband Scope
without any averaging.

Figure 59 - Spectrum averaging time periods
Frequency zoom/dezoom
Zoom/dezoom allows to halve/double the frequency spectrum span, aiming at a
center frequency value which corresponds to the vertical yellow line, representing
the carrier (Figure 61).
Buttons for horizontal zoom/dezoom are shown in Figure 60 and are positioned within
the Spectrum control group of the Narrowband Scope toolbar.

Figure 60 – Zoom/dezoom buttons
Figure 62 shows the Narrowband Scope after zooming the spectrum of Figure 61, by
clicking on the zoom button (the one marked with a “+”).
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Figure 61 - Narrowband scope before zoom

Figure 62 - Narrowband scope after zoom

TitanSDR – User Manual

32

Automatic custom setting of max/min spectrum amplitudes
Narrowband channel spectrum can be resized upward/downward by clicking
up/down arrows (Figure 63).

Figure 63 – Upward/downward spectrum resize buttons

2.3.2

Tuning of narrowband channel

The carrier frequency is indicated in the Edit box on the right of narrowband channel
name.
The highest/lowest possible carrier frequency depends on the number of
narrowband channel allocated in relevant wideband channel:


one narrowband channel allocated: the highest/lowest possible carrier
frequency is that which determines the narrowband channel shaded area to
have its upper/lower end matching 0/40MHz range retuning, if needed,
wideband channel;



two or more narrowband channel allocated: the highest/lowest possible
carrier frequency is that which determines the narrowband channel shaded
area to have its upper/lower end matching the wideband channel
maximum/minimum frequency. Therefore the highest/lowest possible carrier
frequency depends on chosen modulation (mode). In this case wideband
channel can not be retuned.

Tuning of a narrowband channel can be modified by:


Editing the carrier frequency



Turning of mouse wheel up/down



Dragging the narrowband channel shaded area



Frequency shift buttons (of the Tuning controls group)

Tuning by editing the carrier frequency
The narrowband channel carrier frequency in the Edit box of Figure 64 can be
edited and modified by keyboard.

Figure 64 – Carrier frequency edit box
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Any change in the Edit box is given effect to by pressing Enter. As a consequence
the shaded area and the vertical yellow line representing the carrier frequency
move accordingly in the Narrowband Scope, as well as in the Wideband Scope.
Tuning by turning of mouse wheel up/down
By selecting any one digit in the Edit box (Figure 65) and turning the mouse wheel
one step up/down, the narrowband channel carrier frequency increases/decreases
by (the frequency step of) a unitary increase/decrease of that digit.

Figure 65 – Selection of a digit
Tuning by dragging the narrowband channel shaded area
The narrowband channel can be tuned within the Narrowband Scope spectrum by
dragging its shaded area, after having clicked on it. While dragging, the
narrowband channel carrier frequency is modified in the edit box accordingly.
Tuning employing the frequency shift buttons
By clicking and holding down the rightward/leftward arrow button of the Tuning
control group (Figure 66), the carrier frequency increases/decreases by a step set in
“Options->Narrowband->Tuning Step” (see par. 4.5.3 for details). In general
spectrum shifts in the opposite direction, while the shaded area doesn’t move
(except when the narrowband channel approaches one of the wideband channel
ends).

Figure 66 - Frequency shift arrow buttons
The unit of measurement of the narrowband channel carrier frequency can be
selected by the drop-down menu of the Tuning controls group (Figure 67). Possible
choices are: Hz, kHz or MHz .

Figure 67 - Unit of measurement of narrowband channel carrier frequency
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2.3.3

Demodulation settings

The Mode controls group of the Narrowband Scope toolbar (Figure 68) allows to
perform the following operations:


Mode selection



Setting of channel bandwidth



Setting of BFO frequency (for CW, FSK and DRM)

Figure 68 - Mode controls group
Mode selection
Supported modes are listed below:
a) Upper Side Band (USB)
b) Lower Side Band (LSB)
c) Amplitude Modulation (AM)
d) Continuous Wave (CW)
e) Narrowband Frequency Modulation (NFM)
f) Frequency Shift Keying (FSK)
g) Digital Radio Mondiale (DRM)
h) Extended Single Side Band Upper (eSSB-U)
i) Extended Single Side Band Lower (eSSB-U)
By clicking on button of Figure 68 is possible to select a specific mode.
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Default RF bandwidths, minimum RF bandwidths and demodulated audio sampling
rates for supported modes are listed in the table below:
Mode

Default (RF)
bandwidths

Minimum (RF)
bandwidths

Audio sampling
rates

Default BFO
frequency

AM

10000 Hz

200 Hz

11025 Hz

NA

NFM

10000 Hz

400 Hz

22050 Hz

NA

CW

500 Hz

200 Hz

11025 Hz

800 Hz

FSK

2000 Hz

200 Hz

11025Hz

1750 Hz

USB

2500 Hz

100 Hz

11025 Hz

NA

LSB

2500 Hz

100 Hz

11025 Hz

NA

eUSB

10000 Hz

200 Hz

22050Hz

NA

eLSB

10000 Hz

200 Hz

22050Hz

NA

DRM

10000 Hz

400 Hz

Vista, W7: 44100 Hz

12000 Hz

Win XP: 48000 Hz
Selecting “Options->Narrowband->Set modes bandwidth” the default
bandwidth can be customized for each mode (see par 4.5.3 for details).

RF

Setting of channel bandwidth
The RF bandwidth of a narrowband channel can be modified in the following three
ways:
a) In the RF spectrum visualization (see par. 2.3.1), by selecting and dragging the
shaded area edges
b) In the Audio spectrum visualization (see par. 2.3.1):
- by selecting and dragging each of the shaded area edges for modes USB,
LSB, eUSB, eLSB, CW, FSK and DRM
- by selecting and dragging the rightmost edge (the other, the DC edge,
cannot be moved) for AM and NFM
c) In the Edit box of the Mode controls group: by editing the channel bandwidth
and clicking Enter or turning the mouse wheel up/down after selecting any
one digit increasing/decreasing the bandwidth by (the frequency step of) a
unitary increase/decrease of that digit.
RF bandwidths for AM and NFM are bounded above by their audio sampling rate
(see table above).
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RF bandwidths for SSB modes (USB, LSB, eUSB and eLSB) are bounded above by half
their audio sampling rate (see table above).
Maximum RF bandwidths for modes CW, FSK and DRM depend on the BFO
frequency and are equal to:
-

twice the BFO frequency, for BFO frequency lower than a quarter of their
audio sampling rate

-

their audio sampling rate diminished by twice the BFO frequency, for other
BFO frequency values.

Figure 69 and Figure 70 show Audio and RF spectrum visualizations for the USB mode,
respectively, having set the channel bandwidth by selecting and dragging the
edges of the grey shaded area in the Audio spectrum visualization. Those edges
represent the lower and higher cutoff frequencies of bandpass limiting, whose
filtering effect can be clearly noticed on the demodulated audio spectrum.
Notice also the correspondence between the red and grey shaded areas in the RF
and Audio spectrum visualizations (the yellow line, representing the carrier in the RF
spectrum, is indeed mapped to the 0 Hz value at the origin of Audio spectrum
abscissa).

Figure 69 - Audio spectrum visualization for USB mode
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Figure 70 - RF spectrum visualization for USB mode
Setting of BFO frequency
The BFO frequency can be set by:


Editing its value or turning mouse the wheel up/down after selecting any digit
in the edit box in BFO Controls Group which appears when any of modes CW,
FSK and DRM is selected (Figure 71);



Left clicking and dragging the grey shaded area of the Audio spectrum
visualization.

Figure 71 - BFO controls group
BFO negative values are also supported.
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2.3.4

Listening demodulated audio

Output controls group of the Narrowband Scope toolbar (Figure 72) appears by
clicking on the expansion button shown in Figure 73 and allows to manage listening
of demodulated audio by PC loudspeakers/headset by clicking the Audio button.

Figure 72 - Audio controls group

Figure 73 -Expansion button
In order to listen to demodulated audio, it is necessary to first choose the audio card
among the installed ones. By clicking on button “Set”, a window appears (Figure 74)
with the list of available audio cards: choose one and click “Ok”.

Figure 74 - Audio card selection
Note that the list includes also installed VACs (if any), since they are regarded by the
operative system as audio output devices and are not distinguished by real audio
cards. In order to stream demodulated audio to other applications (e.g. software
decoders) by VAC, do not select a VAC from this list, but make the necessary
settings reported in par. 2.3.6.
After having chosen audio card, select the audio mode (Mono, Left or Right) by the
drop-down menu of the Audio controls group (Figure 75).

Figure 75 – Audio mode selection
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The volume can be adjusted by dragging the vertical slider of the Volume menu
(Figure 76).

Figure 76 – Volume adjustment
To start audio, click on the speaker button (Figure 77).

Figure 77 – Speaker button when audio is off
When audio starts, the speaker button icon changes, symbolizing that audio is on
(Figure 78). Click again the speaker button to stop audio.

Figure 78 - Speaker button when audio is on
The listening of demodulated audio of selected NB channel is active by default. To
disable this feature first click on Main Toolbar item “NB List” then uncheck “Listen to
selected channel” (see par. 4.2 for details).
In order to listen to demodulated audio of two narrowband channels in parallel with
one channel on left and the other on the right channel of selected audio card these
are the steps to follow:
 disable “Listen to selected channel” (see par. 4.2 for details);
 select the Left audio mode for the first NB channel and play its audio;
 select the Right audio mode for the second NB channel and play its audio.
2.3.5

Gain control

The Gain controls group of the Narrowband Scope toolbar (Figure 79) appears by
clicking on the expansion button shown in Figure 80 and allows to manage gain
settings.
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Figure 79 – Gain controls group

Figure 80 - Expansion button
The drop-down menu of the Gain controls group (Figure 81) allows to choose among
the following alternatives:


AGC Slow



AGC Fast



Manual

Figure 81 – Gain drop-down menu
By selecting AGC (Automatic Gain Control) Slow or Fast, gain is adjusted
automatically and the horizontal slider (of the Gain controls group) allows to set
output (target) audio level. Furthermore “AGC Slow” features a higher decay time
than “AGC Fast”.
By selecting Manual, gain is constant and can be adjusted manually by the same
horizontal slider.

2.3.6

Audio streaming through Virtual Audio Cables (VAC)

Output controls group of the Narrowband Scope toolbar (Figure 82) appears by
clicking on the expansion button shown in Figure 83 and allows to manage
streaming of demodulated audio to other applications (e.g. software decoders) by
VAC by clicking the VAC button.
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Figure 82 – VAC controls group

Figure 83 - Expansion button
By clicking on button “Set”, a window appears (Figure 84) with the list of installed
VACs: choose one and click “Ok”.

Figure 84 - Installed VACs
Then select the audio mode (Mono, Left or Right) by the drop-down menu of the
VAC controls group (Figure 85).

Figure 85 - VAC audio mode
To start streaming, click on the play button (Figure 86).

Figure 86 – Play button
When streaming starts, the play button icon changes, symbolizing that streaming is
on (Figure 87). Click again the same button to stop streaming.

Figure 87 – Stop button
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The volume can be adjusted by dragging the vertical slider of the Volume menu
(Figure 88). Adjusting volume to a given VAC does not affect the volume of other
VAC.

Figure 88 – Volume adjustment

2.3.7

Audio streaming by LAN

Demulated audio can be forwarded by LAN to other applications (e.g. CODE300
Hoka decoders), running on the same PC (by the loopback address 127.0.0.1) or on
other PCs of a network.
Output controls group of the Narrowband Scope toolbar (Figure 89) appears by
clicking on the expansion button shown in Figure 90 and allows to manage the LAN
forwarding of demodulated audio by clicking the LAN button.

Figure 89 – LAN controls group

Figure 90 - Expansion button
By the LAN button click, it is possible to:
 Set a new TCP connection
 Start and stop streaming on a TCP connection
 Change parameters of an existing TCP connection
 Remove a TCP connection
 Configure Hoka CODE300 decoder based on an IP file
 Request Hoka CODE300 decoder to generate an IP file
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Set a new TCP connection
By clicking the “Set” button, a window appears (Figure 91) with a table that allows
to specify (up to eight) destination IP addresses and associated ports. Each line
refers to a specific destination TCP server. IP address and port can be entered by
editing the corresponding fields. The “Token” field may be edited to entry a name
for the TCP connection. In order to edit a cell, click on the line first (to select it), then
click on the cell.

Figure 91 – Table of TCP connections

Start and stop streaming on a TCP connection
To start streaming of the narrowband channel on a specific TCP connection, select
the corresponding line of the table and click “Ok”.

Figure 92 – Selection of a TCP connection
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Then select which channel/s to employ (Left, Right or Left+Right), by selecting the
corresponding item of the drop-down menu of the LAN controls group(Figure 93).

Figure 93 - Channels selection
Start streaming by clicking the play button (Figure 94).

Figure 94 – Play button
The channel/s employed (Left, Right, Left+Right) by the TCP connection is/are
indicated on the corresponding line of the table (Figure 95). In fact, if the
narrowband channel name appears in the Left or Right field, it means that the left
or right channel is being employed, respectively. If the name appears in both fields,
the same streaming is being transferred by both channels (left and right).

Figure 95 – Narrowband channel WB1-B1 on channel Left
When streaming starts, the play button icon changes, symbolizing that streaming is
on (Figure 96). Click again the same button to stop streaming.

Figure 96 – Stop button
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Change parameters of an existing TCP connection
To modify Token, IP Address and Port of an existing TCP connection, click on its line
first (to select it), then click and edit each cell.
Configure Hoka CODE300 decoder based on an IP file
By connecting a narrowband channel to an instance of the Hoka CODE300
decoder, it is possible to configure the decoder based on a specific IP file. To this
aim:



select the desired IP file from the browse window that opens after clicking the
“Configure Decoder” button;
click “Open” on the browse window .

Request Hoka CODE300 decoder to generate an IP file
By clicking the “Generate IP File” button, a message is sent to the Hoka CODE300
decoder asking it to generate an IP file corresponding to its current settings. The IP
file is generated on PC hosting the decoder instance.
2.3.8

Recording of narrowband channels

TitanSDR allows to record narrowband channel demodulated output in a .wav file.
Files are saved in default folder C:\Users\xyz\Documents\TitanSDR Archives\Wav
(‘xyz’ being the logged user) or in user selected destination folder (see par. 4.5.4 for
details). Files names are assigned automatically (see par. 4.5.4 for details).
TitanSDR provides the user the possibility of setting the upper limit to the filling of the
hard disk. Ongoing recordings are stopped automatically when the available space
set by the user is exceeded (see par. 4.5.5 for details).
Recording can be:


manual



scheduled: see par. 4.4



by session loading: see par. 4.1.2

Manual recording
In order to visualize the Rec controls group, expand the Narrowband Scope toolbar
by clicking on the expansion button shown in Figure 97.

Figure 97 - Expansion button
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Then, to start recording, click the start recording button (Figure 98) within the Rec
controls group (Figure 99).

Figure 98 - Start recording button

Figure 99 - Expanded Narrowband Scope toolbar
If the user selected destination folder to record the narrowband channels is not
detected at record button click a popup appears (Figure 100) warning that
recording is ongoing in default folder “…\Documents\TitanSDR Archives\Wav”

Figure 100 - Narrowband channel recording: warning popup for destination folder
not found

Clicking the start recording button implies changing the button icon into stop
recording button (Figure 101). If it doesn’t happen a window pops up (Figure 102)
warning that the recording did not start for the hard disk free space lower than the
minimum set to prevent the drive from being completely filled up by recording (see
par. 4.5.5 for details).
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Figure 101 - Stop recording button

Figure 102 - Narrowband channel recording: warning popup for not enough disk
space
The Rec controls group includes the recording time, which starts from 00.00.00,
begins to increase after clicking the start recording button and stops increasing at
stop of recording.
Stop of recording implies closing the .wav file. If a new recording is started, a new
.wav file is created (different from the previous one).
2.3.9

S-meter

Level control group (Figure 103) contains S-meter displaying the signal strength at
antenna input under narrowband channel shaded area.

Figure 103 - S-meter
The unit measure can be changed from dBm to S-points by clicking on control group
label or by “Options->Narrowband->Power Level” (see par. 4.5.3 for details)

2.3.10 Notch filter
Each narrowband channel has two notch filters that can be operated
simultaneuosly.
Notch 1 and Notch 2 control group (Figure 104) contains controls dedicated to the
notch filter function: a checkbox to activate/deactivate the filter and two Edit box
for bandwidth and center frequency both expressed in kHz.
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Notch filter bandwith ranges from 75 Hz to 3 kHz whilst the center frequency ranges
the entire NBScope.

Figure 104 – Notch 1 and Notch 2 control group
Notch filter bandwidth and center frequency can be adjusted:



by keyboard editing in the Edit box, any change is given effect to by pressing
Enter;
by selecting any one digit in the Edit box and turning the mouse wheel one
step up/down, the notch filter center frequency or bandwidth
increases/decreases by (the frequency step of) a unitary increase/decrease
of that digit

Center frequency can also be adjusted by mouse dragging
In following Figure 105 and Figure 106 the effect of notch filtering is shown on spectrum
and waterfall
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Figure 105 – Notch 1 activated and filtering tone at 5990 kHz

Figure 106 – Notch 1 and Notch 2 activated and filtering tones at 5990 kHz and
6000 kHz, respectively
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3. Player Mode
Par. 2.2.3 describes how (in Receiver Mode) TitanSDR can record wideband
channels into binary files (proprietary format) with extension .bin.
As anticipated in par. 1.3, TitanSDR can be operated also in Player Mode, which
allows to playback a wideband recording and to allocate narrowband channels
on that recording, working with them as in Receiver Mode.
In order to operate TitanSDR in Player Mode, one of the following conditions must
be met:


The receiver is powered on and connected by USB cable to the PC



The provided USB dongle is plugged into a USB port

To switch to Player Mode, select “Player” from the drop-down menu “Mode” of the
Main Toolbar (Figure 107).

Figure 107 – Player Mode selection
In Player Mode only the Wideband and Narrowband Scope (not the Panoramic
Scope) are present (Figure 108).

Figure 108 - Player Mode
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To open a file, click the button in Figure 109 and browse the window that opens after
clicking (Figure 110).

Figure 109 – Open button

Figure 110 – Selection of a file
Wideband
recordings
are
saved
in
default
folder
C:\Users\xyz\Documents\TitanSDR Archives\WBChannels (‘xyz’ being the logged
user name) or in user defined destination folder.
Playback of recording split among several files can be started from any chunk and
goes on until the last one (chunks pertaining to the same recording have the same
name but the suffix “^000” for the first, “^001” for the second and so on). Removing
an intermediate file chunk from a recording creates a "hole" in the series of file
chunks of that recording: if the playback starts from any chunk preceding the "hole",
it goes on until the "hole".
After selecting a file, click on play button of Figure 111 reproduces recording just
once namely the playback automatically stops at the end of the recording. Note
that the recordings of all possible narrowband channels allocated are
automatically stopped too.
Clicking play button of Figure 112 allows indefinitely looping of reproduction.
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Figure 111 – Play button

Figure 112 – Play loop button
As a result of play button click, the Wideband Scope shows spectrum and waterfall
representation of the recording (Figure 113), the name of file played back, time
elapsed and recording duration.

Figure 113 – Wideband recording playback
At this point, narrowband channels can be allocated performing the same steps
taken in Receiver Mode (Figure 114).
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Figure 114 – Narrowband channels allocated on a recording
The slider located in File control group can be mouse dragged to continue/start the
playback from a desired point.
The rightward and leftward double-arrow (Figure 115) located in File control group
are enabled by selecting a recording split among several files and allow to jump to
the next/previous chunk, respectively. Clicking rightward/leftward double-arrow the
recording playback continues/starts from the beginning of the next/previous
chunck.

Figure 115 – Double-arrow button to jump to the next/previous chunk
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4. Advanced Operations
4.1

Session saving and loading

In Receiver mode, TitanSDR allows to save session settings of receiver Front End,
wideband channels and narrowband channels into session files, with extension .ssn.
A session file includes:


receiver Front-End settings (see par. 2.1.1): selected preselection filter, input
attenuation value and receiver input (HF or IF);



settings of allocated wideband channels:
o bandwidths;
o center frequencies;
o spectrum averaging;
o palette used;



settings of allocated narrowband channels:
o relevant wideband channel;
o narrowband channel name;
o narrowband channel (carrier) frequency;
o (demodulation) mode (par. 2.3.3);
o BFO frequency;
o recording on wave file;
o listening to demodulated audio;
o audio streaming through VAC;
o audio streaming by LAN;
o path to save wave file;
o palette used;
o spectrum averaging setting;
o AGC setting;
o audio and VAC volume settings

Sessions can be restored whenever desired. By restoring of a session, through its
session file, TitanSDR restores Front End settings, allocates automatically all wideband
and narrowband channels that were present when the session file was saved and
restores all their settings listed above.
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4.1.1

Session saving

In order to save the current session, select “Save session as…” from the “File” dropdown menu of the Main Toolbar (Figure 116).

Figure 116 – Session save selection
In the browse window that opens, enter the session file name (default folder is
C:\Users\xyz\Documents\TitanSDR\Sessions, ‘xyz’ being the logged user name)
and click “Save” (Figure 117).

Figure 117 – Browse window
Whenever software disconnects from the receiver (e.g. by clicking the USB button
or by switching from Receiver Mode to Player Mode), the save session message in
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Figure 118 pops up automatically, asking whether to save the current session (into a
.ssn session file) or not.

Figure 118 – Save session message
To circumvent the save session message, deselect “Ask for saving”, after choosing
“Session” from the “Options” drop-down menu of the Main Toolbar (Figure 119).

Figure 119 – Options drop-down menu

4.1.2

Session loading

In order to load (restore) a previous session, select “Load session…” from the “File”
drop-down menu of the Main Toolbar (Figure 120).

Figure 120 – Session selection

In the browse window that opens, select session file to load (default folder is
C:\Users\xyz\Documents\TitanSDR\Sessions, ‘xyz’ being the logged user name)
and click “Open” (Figure 121).
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Figure 121 - Browse window
If not all VAC listed in session file are allocated the warning message of Figure 122
listing the missing ones appears: only installing them before click “Continue…”
button allow the audio streaming through VAC of the relevant NB channels.

Figure 122 -List of VAC not found by session
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If the destination folder requested by session does not match with the one currently
set (see par. 4.5.4 for details) the warning message of Figure 123 appears

Figure 123 - Destination folder not found warning message
Selecting “Change destination folder” opens the browse window to select a new
destination folder. Selection of any option enables the “Continue…” button.

4.2

NB Channels List

The NB Channels List is a table summarizing main settings for the allocated
narrowband channels. The NB Channels List opens by clicking “NB List” on the Main
Toolbar (Figure 124).

Figure 124 – “NB List” on Main Toolbar
Figure 125 shows the NB Channels List after allocation of several narrowband
channels on four distinct wideband channels: each line of the table refers to a
specific narrowband channel. By selecting a line, the Narrowband Scope switches
to the corresponding narrowband channel, showing its controls and its
spectrum/waterfall displays.
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Figure 125 - NB Channels List
In Figure 125 the selected channel is WB4-NB6 (the sixth of the fourth wideband
channel), so its settings could be modified by the Narrowband Scope.
Each line of the NB Channels List contains the following fields:


Name (of narrowband channel)



Frequency (of carrier expressed in kHz)



Bandwidth (of channel expressed in kHz)



Mode (type of demodulator)
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Audio (mono, left or right)



Wav Rec (recording status: “On” of “Off”)



VAC (name of Virtual Audio Cable, if any, fed by demodulator output)



VAC Output (mono, left or right)



LAN (left, right, left+right: see par. 2.3.7)



Memory (memory number, if channel added to memory or allocated from
memory)

Checking “Listen to selected channel” box allows to always listen to the
demodulated audio of the new added/selected NB channel accordingly to the
mode set (Figure 125). Conversely, the user continues to listen to demodulated
audio of the same NB channel, if any, while changing/adding NB channels if “Listen
to selected channel” is unchecked.

4.3

Memory of narrowband channels

Narrowband channels can be memorized, together with stations info, in order to be
easily recognized from a Memory List, presenting all memorized data, and rapidly
allocated again with the same settings. Info saved in memory are:
 center frequency;
 mode;
 bandwidth;
 BFO;
 notch filters status, center frequency and bandwidth;
 AGC mode;
 Callsign, ITU, Station and User Description
The Memory List opens by clicking “Memory” on the Main Toolbar (Figure 126).

Figure 126 - “Memory” on Main Toolbar
Each row of the Memory List (Figure 127) contains the following fields:






Memory (name of)
Name (of narrowband channel, if allocated)
Frequency (of carrier expressed in kHz)
Bandwidth (of channel expressed in kHz)
Mode (type of demodulator)
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Callsign
ITU
Station
User Description

Memories are arranged in a tree structure, highlighted in red on the left side of
Memory List window, to group them for relevance. For further details see par. 4.3.5.

Figure 127 – Memory List window

4.3.1 Memorization
Narrowband channel memorization can be achieved by Memory List window or
Narrowband Scope controls as described below.
Memorize by Memory List window
First select or create a new group to which add the new memory than click Store
button on Memory List window to open Store Frequency window (Figure 128)
containing fields configuring narrowband channel to memorize: Frequency and
Mode are fields to fill mandatory.
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Figure 128 – Store Frequency window to add a narrowband channel to list of
memories
Clicking Store button a new memory entry is added to Memory Window list (Figure
129).

Figure 129 – Memory added editing Store FRequency window
Adding a memory editing fields in Store Frequency window doesn’t require a
wideband recording playing back (TitanSDR in Player mode and USB dongle
plugged into USB a port – see chapter 3) or the receiver connected with software
(TitanSDR in Receiver mode and USB button on Panoramic Scope clicked - see
chapter 2).
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Memorize by Narrowband Scope controls
To memorize a narrowband channel, first expand the Narrowband Scope toolbar
by clicking the expansion button (Figure 80), to access the Memory controls group
(Figure 130).

Figure 130 - Narrowband Scope with expanded toolbar
By clicking “Add” a new record is added to the Memory List, containing the
narrowband channels settings (carrier frequency, bandwidth, mode, notch filters
configuration and AGC mode). Furthermore the assigned memory number is
indicated in the top left colored frame of the Narrowband Scope window (note the
string “Mem009” in Figure 131). By positioning the mouse cursor over the same frame,
the narrowband channel name appears again. Positioning the mouse over the
“Add” button pops-up the currently selected memory group (/Root in Figure 130)
where the narrowband channel will be stored: to change the memory group open
Memory List window and click on the desired group-node of tree structure.
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Figure 131 - Narrowband Scope after clicking “Add”
In order to memorize the other fields (Callsign, ITU, Station, User Description), click the
“Set Info” button of the Memory controls group, edit them in the window that shows
up (Figure 132) and click “Close”.

Figure 132 – Setting of additional info
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The new memory entry appears in the Memory List (note the last line in Figure 133,
starting with “Mem009”).

Figure 133 - Memory List after insertion of new record Mem009

4.3.2 Allocation of memorized channels
In order to allocate a narrowband channel from the Memory List, there must be first
a previously allocated wideband channel which can include it.
By selecting whatever record (line) of the Memory List, a vertical yellow line appears
on the Panoramic Scope spectrum window, in correspondence with the carrier
frequency of the memorized channel (Figure 134).
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Figure 134 – Selection of a line (memorized station) and visualization of
corresponding carrier frequency (yellow line)
By dragging a wideband channel shaded area over the same yellow line, the
corresponding line of the Memory List is rewritten with bold characters, meaning that
the memorized channel can be allocated (Figure 135).

Figure 135 – Wideband channel including Mem009
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Finally, allocation of the memorized channel is obtained by clicking the “Allocate”
button. In general, by performing a multiple selection of lines in the Memory List and
clicking the “Allocate” button, a narrowband channel is allocated for each line
written with bold characters (i.e. whose memorized channel can be included in a
wideband channel).
4.3.3 Memory settings modifications
All the memorized settings of a channel (see par. 4.3) can be modified by means of
Memory List window or Narrowband Scope controls.
Modify memory settings by Memory List window
Opening Memory List window, selecting a record (line) and clicking on Edit button
(see Figure 136) pops up Edit Frequency window with all fields filled with memorized
settings.

Figure 136 – Record selection to modify memory settings
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Editing the fields to modify and clicking Store button on Edit Frequency window
updates memory settings and cells on Memory List window (see Figure 137)

Figure 137 – Updated memory settings and cells. Compare with Figure 136
Modifying a memory editing fields in Edit Frequency window doesn’t require a
wideband recording playing back (TitanSDR in Player mode and USB dongle
plugged into USB a port – see chapter 3) or the receiver connected with software
(TitanSDR in Receiver mode and USB button on Panoramic Scope clicked - see
chapter 2).
Modify memory settings by Narrowband Scope controls
To modify memory settings by Narrowband Scope it is first necessary to allocate a
memorized channel (see par. 4.3.2 ).
Memory settings are modified also in the Memory List, but changes are not yet saved
on disk. In order to save changes applying to a specific narrowband channel, click
the “Update” button of its Memory controls group.
If changes are not saved on disk (by the “Update” button), the message in Figure
138 appears when software is closed, asking whether to save all memory changes
possibly made.
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Figure 138 – Message for update of memories

A similar message appears also (Figure 139) if a single memorized channel, whose
memory settings have changed, is deallocated by the trash button of the
Narrowband Scope or the trash button of the NB Channels controls group (of the
Wideband Scope).

Figure 139 – Message for update of single memory

4.3.4

Removal of memorized channels

To remove a record from the Memory List, select its line and click the “Remove”
button.
4.3.5

Memory group managment

A menu pops-up right clicking inside the tree-view area of “Memory List” window
allowing memory group management (Figure 140). Starting with an empty memory
list the menu allows to add a memory with “Store…” or add a new group with “Add
New Group”. Selecting “Store…” opens “Store Frequency” window (Figure 128) the
same that would open clicking “Store” button on “Memory List” window. Selecting
“Add New Group” opens “New Group Naming” window (Figure 141) to assign a
name to group added.
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Figure 140 – Memory group managment

Figure 141 – Assigning a name to a new memory group
Selecting a group node and right clicking pops-up menu in Figure 140 with all items
available:


“Delete Group” - removes a group including all memories and subgroup
contained;



“Rename Group” – opens “Group Renaming” window to enter the new group
name



“Show All” – expands all the tree nodes.

Selecting a memory node and right clicking pops-up a menu in Figure 142:


“Edit…” – to change memory settings, analogous to “Edit…” button on
“Memory List” window



“Remove” – to remove the selected memory, analogous to “Remove” button
on “Memory List” window

TitanSDR – User Manual

71

Figure 142 – Memory managment from tree structure
Clicking on a group node lists all the memories it contains (Figure 143) whilst clicking
on a memory node lists all the memories contained in parent group node
highlighting the record in the list corresponding to the clicked memory node (Figure
144).
Clicking a record in the list highlight the corresponding memory node.

Figure 143 – Memories listed by clicking SubGroup1_1
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Figure 144 – Memories listed by clicking memory labeled “4000.000”
Memories can be moved from one group to another in two ways:
 selecting on tree structure a memory than dragging to the desired memory
group node and dropping;
 selecting on the list the memories to move than clicking “Move to…” button
that opens “Move memory…” window: clicking on a tree node in “Move
memory…” window moves memories to that group and update list and tree
view area in “Memory List” window. In Figure 146-a,c is illustrated Mem007 and
Mem009 moving from SubGroup2 to Root

Figure 145 – a – Mem007 and Mem009 selection

Figure 146 – b – “Move memory…” opened clicking “Move to…” button
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Figure 147 – c – Mem007 and Mem009 moved to Root and list updated

4.4

Scheduling of recordings

Both recording of wideband and narrowband channels can be scheduled. While
TitanSDR takes care to start/stop recordings on scheduled channels, the other
channels can be normally employed in parallel. This subject is divided in the
following paragraphs:



4.4.1 - Scheduling of a new wideband\narrowband channel: describes the
necessary steps to set recording tasks for a wideband\narrowband channel
and how recording tasks are handled.



4.4.2 - Task Editor window: gives practical examples for setting both notperiodic and periodic tasks



4.4.3 - Managing scheduled channels: describes how it is possible to monitor
and manage all the recording activities from the Scheduled Channels
window



4.4.4 - Allocation of scheduled channels: describes how to newly allocate
scheduled channels from the Scheduled Channels window (after they have
been deallocated, even as a consequence of software shutdown)

4.4.1 Scheduling of a new wideband\narrowband channel
In order to schedule recordings of a wideband channel, click on the Schedule
button (Figure 148) within the File controls group (of the expanded Wideband Scope
toolbar), to open its Recording Schedule window (Figure 149).
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Figure 148 - Expanded Wideband Scope toolbar

Figure 149 - Recording Schedule window

In a similar way, to schedule recordings of a narrowband channel, click on the
Schedule button (Figure 150) within the Rec controls group (of the expanded
Narrowband Scope toolbar), to open its Recording Schedule window.
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Figure 150 - Expanded Narrowband Scope toolbar
The Recording Schedule window allows to set recording tasks for the channel: each
line corresponds to a specific task.
To add a new task, click the “Add” button. This opens the Task Editor window (Figure
151), which allows to specify dates and times for start and stop of the recording and
to set possible repetitions (see par. 4.4.2 for examples). In fact tasks can be periodic
or not periodic. Not periodic tasks are executed once. Periodic tasks are those
which have to be executed on specific days of the week.

Figure 151 - Task Editor window

After entering all task’s data, click “Ok”: the new task is added to the Recording
schedule window as a new line (Figure 152).
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Figure 152 - Recording Schedule window with first entered task
A task can be active or not. Only active tasks are executed. A task is active if the
cell of the Active field (second column) is “Yes”. If this cell is “No”, the task will never
be executed. When a new task is created, it is activated by default (i.e. Active field
cell is “Yes”). In order to deactivate/activate a task, left click on this cell.
The following rules apply:











If two tasks of two different wideband channel have overlapping recording
time intervals, the one which is executed is that with the earliest start time
(the other one is not executed at all)
A recording tasks doesn’t start if recording of the same channel has been
already started manually
If a task is being executed (i.e. recording is ongoing), recording can be
stopped manually (before the task stop time)
During execution of a task, its start time and stop time can be modified
manually (which causes the recording to stop, if the stop time is set earlier
than current time or if the start time is set later than current time)
If a task is being executed and its Active field cell is set to “No”, recording is
stopped
Task doesn’t start if the browse window to change the destination folder for
recording (see par. 4.5.4 for details) is open: it waits to start until the window
is closed
If destination folder is not found (see par. 4.5.4 for details) recording takes
place
in
default
folder
C:\Users\xyz\Documents\TitanSDR
Archives\WBChannels (‘xyz’ being the logged user name) for WB channel
and in default folder C:\Users\xyz\Documents\TitanSDR Archives\Wav for
NB channels
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4.4.2

Task Editor window

The following paragraphs address scheduling, through the Task Editor window, for:



Not Periodic tasks
Periodic tasks

Not Periodic schedule:
The maximum recording duration of a task is 24 hours. After specifying the start date
and the start time, it is possible to set the recording duration (Rec length) or the stop
date and stop time.
Find below two examples. In Examples 1, the recording duration is 14 hours and both
start and stop are in the same day. In Example 2, the recording duration is 21 hours
and start and stop are in consecutive days.
Example 1:
START DATE=14/11/2012
START TIME=8:00
STOP DATE=14/11/2012
STOP TIME=21:00
Duration: 13 hours
DAY OF SCHEDULING: 03/11/2012
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Figure 153 - Task Editor settings for Example 1
Example 2
START DATE=12/11/2012
START TIME=11:00
STOP DATE=13/11/2012
STOP TIME=06:00
Duration: 19 hours
DAY OF SCHEDULING: 03/11/2012
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Figure 154 - Task Editor settings for Example 2
Periodic schedule:
Set start date, start time, stop date and stop time of the task. Check the “Repeat
on” checkbox, to enable periodic scheduling. To specify the task’s subsequent
repetitions:



check the days of the week, when task must be repeated;
check the “Until” checkbox and set the last date for task repetition or leave
the “Until” checkbox not checked, for unlimited task repetitions.

Example 3 below refers to a periodic task, which has to be executed on Wednesday,
Thursday, Friday and Saturday, from 8:00 to 21:00 (Figure 155).

Example 3:
START DATE=10/11/2012
START TIME=8:00
STOP DATE=10/11/2012
STOP TIME=21:00
Duration: 13 hours
TASK REPETITIONS ON: Wednesday, Thursday, Friday and Saturday
UNTIL DATE: 22/11/2012
DAY OF SCHEDULING: 03/11/2012
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Note that, even if the start date is 10/11, the task is executed first on 12/11, which
happens to be the first day (not preceding the start day) which matches one of the
days of week of interest (i.e. which are checked), that is Wednesday. The last day
the task is executed is 22/11.

Figure 155 - Task Editor settings for Example 3
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4.4.3

Managing scheduled channels

All scheduled channels, both wideband and narrowband types, are listed in the
Scheduled Channels window, containing the list of scheduled wideband and
narrowband channels, which appears by clicking the “Schedule” menu of the Main
Toolbar.
For example, Figure 156 shows the Scheduled Channels window for two wideband
channels (Sch 001, Sch 002) and seven narrowband channels (Sch 003, …, Sch 009).

Figure 156 - Scheduled Channels window

The Scheduled Channels window contains the following fields:









Schedule (name of)
Type (WB or NB, for a wideband or narrowband channel, respectively)
Name (of wideband or narrowband channel, if already allocated)
Frequency (center frequency for wideband channels, carrier frequency for
narrowband channels, expressed in kHz)
Bandwidth (of wideband or narrowband channel, expressed in kHz)
Mode (of narrowband channel)
Recording (“On” if recording is ongoing, “Off” otherwise)
Status (“Off” if channel is not allocated, “Enabled” if there are active tasks,
“Disabled” if there aren’t active tasks)

Scheduled recordings can be removed from the list by selecting them and clicking
the “Remove” button.
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The Recording Schedule window, containing the tasks for a specific scheduled
channel, appears by selecting its line (on the list of Scheduled Channels) and
clicking the “Show Tasks” button. Figure 157 shows the Recording Schedule window
for Sch4 (Figure 156), i.e. for the narrowband channel WB3-NB2.

Figure 157 – Recording tasks for narrowband channel WB3-NB2
The settings of a task can be modified by the Task Editor window (see par. 4.4.2 for
details), which shows up by selecting the task line on the Recording Schedule
window and clicking the “Edit” button (Figure 158).

Figure 158 - Task Editor window
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4.4.4

Allocation of scheduled channels

Scheduled channels and their recording tasks are saved on disk and can be
recalled at any time, even after software shutdown and restart. In particular, the
Scheduled Channels window appears by clicking the “Schedule” menu of the Main
Toolbar.
Nevertheless, at software start, scheduled channels are not allocated and must be
allocated first, if their recording tasks are to be executed. The following paragraphs
describe how allocations of scheduled wideband and narrowband channels can
be accomplished, through the Scheduled Channels window.
Allocation of scheduled wideband channels
A scheduled wideband channel can be allocated if it appears in bold characters
in the Scheduled Channel window, meaning that there are sufficient resources
available for its allocation. Figure 159 shows, for instance, the Scheduled Channel
window with three wideband channels in bold characters. Therefore any of them
can be allocated.

Figure 159 – Scheduled Channels window with an allocable wideband channel
selected
In order to allocate a WB channel, select its line and click the “Allocate” button.
Multiple selection of channels to allocate is also possible: they are allocated from
the highest to the lowest of selection, until resources are available, after clicking the
“Allocate” button once.
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By selecting and allocating a wideband channel, the assigned wideband channel
name appears in the “Name” field (of the Scheduled Channels window list) and its
line is no longer written in bold characters. For instance, Figure 160 shows the
Scheduled Channels window after allocating the selected wideband channel in
Figure 159, as WB1. The red shaded area of WB1 is also visible in the Panoramic
Scope spectrum.

Figure 160 – Allocation of Sch 005 as WB1
Continuing the example of Figure 159 and Figure 160, by selecting the second
wideband channel Sch 004 of the Scheduled Channel window list, as illustrated in
Figure 161, and allocating it, the corresponding (second) line of the list is now written
in normal characters (as expected), as well as the third line of Sch 006, meaning that
for the allocation of this last channel there aren’t enough resources left (Figure 162).

Figure 161 – Selection of second wideband channel

TitanSDR – User Manual

85

Figure 162 - Allocation of Sch 004 as WB2
Allocation of scheduled narrowband channels
By selecting a line of the scheduled narrowband channels in the Scheduled
Channels window list, a blue vertical line appears on the Panoramic Scope
spectrum in correspondence with its carrier frequency. This is the case of Sch 016 in
Figure 163.

Figure 163 – Selection of a scheduled narrowband channel
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By allocating a wideband channel and dragging its shaded area over the same
blue line, the corresponding line of the list is rewritten with bold characters, meaning
that the narrowband scheduled channel can now be allocated, as in Figure 164 for
Sch 016.

Figure 164 – Allocation and drag of a wideband channel
To allocate the narrowband channel click the “Allocate” button. Figure 165 shows
allocation of Sch 0016 of Figure 164.

Figure 165 – Narrowband channel allocation
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4.5

Options

By the Options drop-down menu of the Main Toolbar, several advanced software
features can be managed (Figure 166). These options are described in the following
paragraphs.

Figure 166 - Menu Options

4.5.1

Panoramic

By selecting the Panoramic option, a list appears with the following items (Figure
167):


Labels



Centring



32 MHz



40 MHz

Figure 167 – Items of Panoramic option
Labels: by unchecking this item, the dB labels on the Panoramic Scope spectrum
disappear.
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Centring: by selecting this item the window of Figure 168 appears containing sliders
to set Panoramic spectrum display. “Range” slider set the difference between
maximum and minimum signal level displayed on Panoramic spectrum: slider mouse
drag changes maximum displayed signal level keeping constant minimum level.
“Bottom” slider set minimum signal level displayed keeping “Range” constant.

Figure 168 - Panoramic spectrum display set
32MHz\40MHz: this items are mutually exclusive. “32MHz” is checked by default.
If “32MHz” or ”40MHz” is checked, the Panoramic Scope spectrum spans from 0Hz
to 32MHz or 40MHz, respectively.
4.5.2

Wideband

By selecting the Wideband option, a list appears with the following items (Figure
169):


Labels



Centring



Palette, allowing to access the following submenu


Change



Setting



Range
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Figure 169 - Items of Wideband option
Labels: by unchecking this item, the dB labels on the Wideband Scope spectrum
disappear.
Centring: by selecting this item the window of Figure 170 appears containing sliders
to set Wideband spectrum display. “Range” slider set the difference between
maximum and minimum signal level displayed on Wideband spectrum: slider mouse
drag changes maximum displayed signal level keeping constant minimum level.
“Bottom” slider set minimum signal level displayed keeping “Range” constant.

Figure 170 - Wideband spectrum display set
Palette Change: by selecting this item, a list appears of selectable palettes for the
wideband waterfall display. TitanSDR provides a default set of 7 palettes. This set can
be extended by the user, by putting
*.pal files within the
C:\Users\xyz\Documents\TitanSDR\pal (‘xyz’ being the logged user) folder.
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Palette Setting: this item allows to select mapping between palette colors and
spectrum amplitudes (ordinates), for the wideband waterfall display. Mapping
alternatives are listed below:


Default: the range of palette colors (from bottom to top color) matches the
ordinates range of wideband spectrum (from -160 to 0 dB)



Weak signals: bottom color spectrum ordinate is set automatically just above
the noise floor to ease recognition of weak signals. The range of palette colors
(from bottom to top color) maps to a 30 dB spectrum range (starting from
the bottom color spectrum ordinate).



Custom: when this item is selected, a colors map appears on the right of the
wideband spectrum (Figure 171), showing what color is associated to what
spectrum ordinate. Furthermore horizontal yellow lines are drawn, which can
be selected and adjusted by vertical dragging, marking the amplitude range
between bottom and top palette colors. Note that ordinates outside this
range are saturated to bottom or top palette colors.

Figure 171 – Custom palette setting
Palette Range: unchecking this item after having chosen the “Custom” palette
setting, makes both the colors map and the horizontal yellow lines (marking the
amplitude range between bottom and top palette colors) disappear.
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4.5.3

Narrowband

By selecting the Narrowband option, a list appears with the following items (Figure
172):


Labels



Centring



Palette, allowing to access the following submenu


Change



Setting



Range



Power Level



Tuning Step



Tuning Round



Set modes bandwidth



Set default volume

Figure 172 - Items of Narrowband option
Labels: by unchecking this item, the dB labels on the Narrowband Scope spectrum
disappear.
Centring: by selecting this item the window of Figure 173 appears containing sliders
to set Narrowband spectrum display. “Range” slider set the difference between
maximum and minimum signal level displayed on Narrowband spectrum: slider
mouse drag changes maximum displayed signal level keeping constant minimum
level. “Bottom” slider set minimum signal level displayed keeping “Range” constant.
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Figure 173 - Narrowband spectrum display set
Palette Change: by selecting this item, a list appears of selectable palettes for the
narrowband waterfall display. TitanSDR provides a default set of 7 palettes. This set
can be extended by the user, by putting
*.pal files within the
C:\Users\xyz\Documents\TitanSDR\pal (‘xyz’ being the logged user) folder.
Palette Setting: this item allows to select mapping between palette colors and
spectrum amplitudes (ordinates), for the narrowband waterfall display (both of RF
and demodulated audio). Mapping alternatives are listed below:


Default: the range of palette colors (from bottom to top color) matches the
ordinates range of narrowband spectrum (from -160 to 0 dB for RF and from
-100 to 0 dB for demodulated audio)



Weak signals: bottom color RF spectrum ordinate is set automatically just
above the noise floor to ease recognition of weak signals. The range of
palette colors (from bottom to top color) maps to a 30 dB RF spectrum range
(starting from the bottom color spectrum ordinate).



Custom: when this item is selected, a colors map appears on the right of the
narrowband spectrum of RF and demodulated audio (Figure 174), showing
what color is associated to what spectrum ordinate. Furthermore horizontal
yellow lines are drawn, which can be selected and adjusted by vertical
dragging, marking the amplitude range between bottom and top palette
colors. Note that ordinates outside this range are saturated to bottom or top
palette colors.
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Figure 174 – Custom palette setting for spectrum of demodulated audio
Palette Range: unchecking this item after having chosen the “Custom” palette
setting, makes both the colors map and the horizontal yellow lines (marking the
amplitude range between bottom and top palette colors) disappear.
Power level: opens a submenu to set the unit measure dBm or S-point of the the Smeter located in Narrowband Scope toolbar.
Tuning Step: opens a submenu to set the tuning step from 100 Hz to 5 kHz for tuning
by frequency shift buttons (see par. 2.3.2).
Tuning Round: to select the center frequency rounding to apply allocating a
narrowband channel (see par. 2.2.2)
Set modes bandwidth: opens the window of Figure 175 to set the default values of
the RF bandwidths for each mode. New settings only apply to narrowband channels
allocated after closing “Modes Default Bandiwdth” window.
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Figure 175 - Set of default RF bandwidths
Set default volume: opens the window in Figure 176 to set the default volume for
audio and VAC to apply to each narrowband channel allocated.

Figure 176 – Default audio and VAC volume setting

TitanSDR – User Manual

95

4.5.4

Output Files Set

Wideband and narrowband channels can be recorded as described in par. 2.2.3
and 2.3.8, respectively.
The “Output Files Customization” window, which appears by selecting option
“Output Files Set”, from the Main Toolbar (Figure 177) allows to set destination folders
and files names for wideband and narrowband recording.
The browse button in Current Folder control group allows to change the destination
folder and the selected one is displayed.
Files names (*.bin and *.wav for wideband and narrowband recordings,
respectively) are assigned automatically and result from concatenation of various
possible fields.

Figure 177 - Output Files Customization window
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Wideband recording:
The fields which can be concatenated to compose the names of *.bin files are listed
below:


User Defined String (“WB_channel” in Figure 177)



date (year, month and day of recording, formatted as: YYYYMMDD)



start rec time (recording start time, formatted as: HHMMSS)



minimum frequency in Hz (of wideband channel)



maximum frequency in Hz (of wideband channel)



central frequency in Hz (of wideband channel)

Time of field “start rec time” can be UTC or local time (of PC), based on
corresponding selection.
Files names are composed by concatenation of the selected fields. Field
selection/deselection is by clicking the corresponding checkbox. Because
recording is split among several files the policy to assign name to chunks is as follows:
the name of first file has the default suffix ‘^000’, possible further files have suffix
‘^001’, ‘^002’,…etc.
The top editbox shows how concatenation of selected fields will result.
Editing the bottom editbox chunck size can be set within the range of 50MB to 2GB.
Narrowband recording:
The fields which can be concatenated to compose the names of *.wav files are
listed below:


User Defined String



Date (year, month and day of recording, formatted as: YYYYMMDD)



start rec time (recording start time, formatted as: HHMMSS)



stop rec time (recording stop time, formatted as: HHMMSS)



carrier frequency in Hz (of narrowband channel)



mode (of demodulation)



BFO (frequency)

Time of fields “start rec time” and “stop rec time” can be UTC or local time (of PC),
based on corresponding selection.
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Files names are composed by concatenation of the selected fields. Field
selection/deselection is by clicking the corresponding checkbox.
The top editbox shows how concatenation of selected fields will result.

4.5.5

Storage

To prevent the hard disk containing the destination recording folder from being
completely filled up by recording of wideband/narrowband channels, it is possible
to set the minimum hard disk space which must be left free. This can be done by the
“HD Space Limiting” window, which appears by selecting the “Storage” option of
the Main Toolbar (Figure 178).
Minimum percentage of hard disk size to be left free can be entered in the edit box.
Ongoing (wideband and/or narrowband) recordings are automatically stopped if
hard disk free space becomes lower than this minimum.

Figure 178 - HD Space Limiting
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4.5.6

Session

Whenever software disconnects from the receiver (e.g. by clicking the USB button
or by switching from Receiver Mode to Player Mode), the save session message in
Figure 179 pops up automatically asking whether to save the current session (into a
.ssn session file) or not.

Figure 179 – Save session message
To circumvent the save session message, deselect “Ask for saving”, after choosing
“Session” from the “Options” drop-down menu of the Main Toolbar (Figure 180).

Figure 180 – Options drop-down menu
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5. Appendix
5.1

Table of limiting wideband channels combinations

Table below provides possible combinations of WB channels, which make maximum
use of resources (i.e. when these combinations are realized, no more WB channels
can be allocated)

Combinations of WB Chs

No. of
Chs
1
2
3
4
5
6
7
8
9
10
11

312,5

625,5

WB channel size (kHz)
937,5
1250
1562,5

1875

2187,5
1

1
1

1
1

1
1

1
1
2
1
2
4
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1
1

2
1
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5.2

Hotkeys to manage a narrowband channel
Narrowband Scope

Ctrl + a
Ctrl + u
Ctrl + l
Ctrl + c
Ctrl + n
Ctrl + f
Ctrl + d
Ctrl + ù
Ctrl + e
Ctrl + canc
Ctrl + p
Ctrl + h
Ctrl + y
Ctrl + r
Ctrl + k
Ctrl + j
Ctrl + t
Ctrl + m
Ctrl + b
Ctrl + i
Ctrl + v
Ctrl + g
Ctrl + ‘:’
Ctrl + ‘;’
Ctrl + o
Ctrl + x
Ctrl + s
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Select AM mode
Select USB mode
Select LSB mode
Select CW mode
Select NFM mode
Select FSK mode
Select DRM mode
Select eUSB (extended USB) mode
Select eLSB (extended LSB) mode
Delete narrowband channel
Play/Stop Audio/VAC
Decrease Audio/VAC volume
Increse Audio/VAC volume
Start/Stop wave file recording
Increase narrowband channel carrier
frequency
Decrease narrowband channel carrier
frequency
Select narrowband channel carrier
frequency
Select narrowband channel bandwidth
Select narrowband channel BFO edit
Change RF/Audio spectrum view
Narrowband
channel
spectrum
averaging
Select AGC mode
Increase gain when AGC manual
Decrease gain when AGC manual
Select Audio/VAC/LAN output
Widen/narrow Narrowband Scope
panel
Click “Set” button in “Output” group
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